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Redlands Camera Club is a group of amateur, serious-amateur, and professional photographers who are 
interested in sharing experiences and advancing their skills.  Anyone with similar interests is encouraged 

to attend a meeting at no cost or obligation. 
We meet at 7:00 pm on the first and third Mondays of every month at Redlands United Church of Christ, 

168 Bellevue Avenue, Redlands, CA (see back page for map). 

Best Of Show - Spring Digital Competition 

  
 

April ,  2010 

 

PP HH OO TT OO GG RR AA MM   
Distributed on the 1st of each month. 
Deadline for all submissions is the    

Last Thursday of each month. 
 

Editor: Steve Felber 
(951) 769-6898 

SNFelber@Yahoo.com 

©©  RReeddllaannddss  CCaammeerraa  CClluubb  aanndd  iittss  CCoonnttrriibbuuttoorrss..  
The  contents of the Photogram are copyrighted. 

No material herein may be reproduced in any manner 
without the written permission of the Editor 

or the material’s specific contributor. 
 

Jackson Hole Lake; Rick Strobaugh 

  

 

 

 

 

 

 

 

 

 

 

 

May  3 

MEMBERS'    
NIGHT 

Bring up to 3 images 

April 5 

MASTERING PRINT 
COMPETITIONS 

Alan Mayer 

April 19 

UNDERWATER 
IMAGING 

Shawn Gibbs 

May 17 

PHOTOGRAPHING 
MOJAVE 

David J. McChesney 
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CCC lll uuu bbb    
E s t a b l i s h e d  1 8 9 6  
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THE VIEW FROM HERE 

 Bruce Bonnett 

Redlands Camera Club   P.O. Box 7261  Redlands, CA  92375 
www.RedlandsCameraClub.com 

CLUB OFFICERS 
President: Bruce Bonnett      Vice President: Bruce Woodcock        Past President: Judith Sparhawk 

Secretary: Jerry Reece  Treasurer: Rick Strobaugh 
CHAIRS 

Circulation: Karen Fabrizio Competition: Wayne Wood Exhibits: Carol Abidin     Education: Frank Peele 
Field Trips: Judith Sparhawk  Hospitality: Steve Oberholtzer       Librarian: Mike Reid 

 Member-At-Large: Larry Cowles   Membership: Bessie Reece   Photogram Editor: Steve Felber 
Programs: Bruce Woodcock  Publicity: Nancy Yowell  Webmaster: Wayne Wood 

Make your subject pop with shallow Depth Of Field 
One of the simplest ways to improve your photography is to go minimal.  Examine your scene and boil it 
down to the essential details.  Pick a single detail and use a shallow Depth Of Field to isolate it from its 
surroundings.  Choose the proper lens; a long lens will provide shallow D.O.F.; a wide lens will provide 
much greater D.O.F.  Getting closer to your subject will also maximize D.O.F.  When focused on Infinity, a 
lens may be sharp from 50 feet to infinity:  when focused only a few feet from the camera, the D.O.F. 
may be microscopic.   

The formula is simple: A long lens + a maximum aperture (f-2.8) + a close focusing point = simplicity and 
success. 

 

As we move into a new year for the Redlands Camera Club (RCC) and my first year as your new President,   
I want to express my appreciation and that of the entire Club to Judith  
Sparhawk, the Board members and the committees for their outstanding contributions during the previous 
years. Through their efforts we have seen a substantial growth in membership and participation as well as 
new tools and services being made available to members.  It takes a lot of willing volunteers to keep RCC 
running well and I’m confident that this coming year, with your continued support and service, we will 
continue to see great strides for the Club. 

Thanks also go out to Steve Oberholzer and those who helped make our Annual Banquet a success.  Great 
food, great friends, and good times were had by all.  The whole evening was a flurry of activity.  In addition 
to the dinner, we had the installation of new (and continuing) officers and committee chairs, the awarding of 
ribbons to the winners of our recent digital competition, and the selection of images for the Redlands 
Horticultural Society’s Flower Show exhibit. 

Thanks Woody (Wayne Wood) for your hard work on making the competition a success.  Kudos to all who 
submitted their work to the competition and congratulations to all the winners! 

Congratulations also go out to those who had their images selected for the flower show exhibit.  It was a 
tough choice for us all to select from so many beautiful images.  This is the third year that our Club has been 
selected to exhibit by the Redlands Horticultural Society and it is a wonderful opportunity to showcase our 
talent and artistry.   And speaking of flowers, spring is here. Flowers are blooming. It’s time to get out and 
shoot for next year’s show!  
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APRIL 19TH                

Underwater Imaging; Shawn Gibbs 

UPCOMING PROGRAMS 

       Bruce Woodcock 

APRIL 5TH                      

Mastering Print Competitions; Alan Mayer 

Photoshop & Elements tip:  Keyboard-driven Opacity settings 

With the Move (arrow) tool active, press the numbers on your keyboard to change the active layer’s 
Opacity.  0 = 100%, 1 = 10%, 2 = 20%, 3 = 30%, etc.  If you want a more specific number, type it in – such 
as 33 = 33%.  This works on an entire image (Background) or any Layer that you have active. 

If you have another tool active that has its own opacity setting -- such as a brush or clone tool, your 
keyboard numbers will change that tool’s opacity, rather than the layer’s or image’s opacity. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Join Alan Mayer and learn from the master the secrets of meriting in print competitions.  Mr. Mayer will 
cover design, adding complimenting elements, Photoshop layering, telling a story with your image, and the 
fine art of naming your masterpiece. 

Shawn Gibbs will talk about the gear used in underwater photography.  He'll also explain the differences 
between land shooting and underwater shooting.  We will then enjoy a slide show of underwater images 
from trips to Honduras, Florida, and up and down the California Coast. 

 

On a space-available basis, Notices, Requests and For Sale ads may be posted by any member.  300 dpi JPEG pictures may be included.         
All postings must be photography-related and include your name and contact information.                                                                                                 

See Photogram Submissions box for deadline and submission information. 

RCC Bulletin Board 

Photography Classes at Redlands Adult School 
This may be the last time these classes will be available! Due to the state’s budget crisis, the Adult School may be closed 

down after this semester.  Now is the time to act! 

Classes are taught by Frank Peele,  Certified Professional Photographer 

Advanced Adobe Photoshop Elements 8 
Tuesdays 6 – 9 p.m., Apr 27 - Jun 1.  Continuation of the above class, which is a prerequisite. 

All tuitions are $60. To register or for more information, go to www.redlandsadultschool.org, call (909) 748-6930,                                                   
or go to the school office at 10568 California St., Redlands. 

These classes do fill up, so early registration is advised. 

http://www.redlandsadultschool.org/�
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PRINT EXHIBIT RULES 
The work must be yours, a current member of RCC.   

It must be ready to hang using wire eyes & wire; 
no saw tooth hangers.   

You may use a frameless presentation. 
Your name, title of the picture, and sale price (if for sale)                       

must be on the back. 
There is a $3.00 fee for each work hung: cash or check. 

Work left for another hanging will be charged again. 
Work removed but not retrieved after a new hanging                      

will be charged a $3.00 storage fee. 
Work unclaimed within 60 days of removal will be considered 

abandoned and become the property of Redlands Camera Club  
for disposal or sale at its sole discretion. 

WEBMASTER/COMPETITION 

      Wayne (Woody) Wood 

Our Spring Digital competition was a huge success. 
Congratulations to all who won ribbons. Special 
congratulations to Rick Strobaugh for his beautiful Best 
of Show winning image, "Jackson Hole Lake". 

It was also nice to see some of our newer members 
winning ribbons. Keep up the good work! 

We had 64 members enter a total of 246 images. That is 
far more than our last competition. Thanks to all who 
entered. 

Thanks  also to Larry Cowles for his blog about places 
to visit and photograph in Southern California. It's 
called  SoCal Photo Opps and can be found on our web 
site under the "Activities" and "Links" buttons on the 
left of each page. 

The  2010 competition schedule and information 
documents are now on the web site.  

From now on all image files entered in the print and 
digital competitions, as well as members nights, will 
be named in the following manner: the title of your 
image will be the file name.  If the title of your image is 
Stormy Weather then your file name will be 
stormyweather and it should be saved as a JPG file, 
meaning it will appear as stormyweather.jpg.  Please 
don't put any punctuation, capitol letters or spaces in 
the file name.  
 

EXHIBITS 

      Carol Abidin 

Exhibit Schedule for 2010 
 

Where 
Hanging 

Dates 
Take-In 
Times 

Redlands City Hall February 11 3 – 5 

Redlands Community Hospital March 6 10 - Noon 

Redlands City Hall April 8 3 – 5 

Redlands Community Hospital May 8 10 - Noon 

Redlands City Hall June 3 3 – 5 

Redlands Community Hospital July 10 10 - Noon 

Redlands City Hall August 5 3 – 5 

Redlands Community Hospital September 11 10 - Noon 

Redlands City Hall October 7 3 – 5 

Redlands Community Hospital November 6 10 - Noon 

Redlands City Hall December 2 3 – 5 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Next Hanging: Redlands City Hall 
Thursday, April 8 from 3:00 to 5:00 

Join your club members and bring a photograph to show 
the community our talents at RCC. See the Print Exhibit 
Rules for requirements.  

If you have photographs currently hanging at City Hall 
that have not been sold, you can let them hang again 
and/or bring new ones with a cost of only $3.00 for 
each.  

After hanging your pictures, bring friends and family to 
show them what RCC is all about. 
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MEMBERSHIP 

    Bessie Reece 

Photoshop & Elements tip:  Use Guide Lines 

Need a straight line to guide you?  Sometimes, we need to straighten a horizon or draw a straight line, or make 
sure a tree or other object is straight up and down.  These are great times to use guide lines.  Getting them is 
simple.  First, make sure your Rulers are visible in an opened file (they won't show until a file is opened).  If not, 
click on View > Rulers.   
Place your cursor inside the horizontal ruler at the top of the file, click and hold then pull a horizontal guide line 
out of the ruler.  Voila; you have a guide line!  Position it wherever you like.   
For vertical guide lines, do the same thing from the left-hand vertical ruler.   
You can make as many guide lines as you like (they're really helpful for making boxes).  When you want to put 
them away, just click and hold on each guide line and drag it off the edge of the image. 
 

 
 
 

Membership for April 2010 to March 2011 is now due.  If you haven’t got yours in yet, remember to pick 
up your renewal form at the April 5th meeting OR print a copy of the membership form from our website 
www.redlandscameraclub.com  and mail it with your check to the PO Box listed on the application.   If you 
have already got your renewal in, welcome to the 2010-2011 year.    We have a great year planned that you 
won’t want to miss. 

New Members:   
Sharon Skonetski:  Sharon began photography at the age of seven when she borrowed her parents’ camera 
and began shooting.  This experience evolved into having her own darkroom and studio when she was in her 
twenties.  She lost interest in photography for a while and rekindled her interest about ten years ago.  She 
shoots portraits, weddings, and landscapes.  Sharon is now totally immersed in photography and shoots 
almost every day.  She enjoys meeting other photographers, learning from them and helping others.  Sharon 
feels that every photographer is unique and because of this, she enjoys sharing with others. 

Lois Bryant:  Lois is new to digital photography and hopes her membership in RCC will help her to become 
a better photographer.  She is presently using a point and shoot camera.  Lois is retired from Redlands High 
School where she taught biology and English for some 34 years.  She does a lot of travel photography which 
she shares with friends.  Lois also enjoys photographing plants and animals.  She is learning to use 
Photoshop Elements to process her work.  Through her membership in RCC, Lois hopes to learn more about 
photography and increase her skills. 

Bill Wendt:  Bill and his wife, Sally, are retired and living in Yucaipa.  Bill has been taking pictures since 
the 1960’s.  He enjoys making albums, recording the events in the lives of their three children and 
grandchildren.  Recently Bill and Sally took an RV trip throughout the United States and Canada.  Bill 
enjoys photographing the National Parks and major State Capitals.  Lately he has developed an interest in 
photographing flowers, birds, and butterflies with his Canon 50D.  He hopes to learn more about 
photography and editing through his membership in the club.   

Richard De Rose:  Richard shoots with a Canon xti, having started out his SLR days with a Canon AE1.  
However, with raising a family, etc, he has had a 30 year break from serious photography.  He liked to shoot 
landscapes and flowers using a flash often for fill flash and back lighting.   Richard is interested in meeting 
other photographers that can help him come up to speed in the digital world and is interested in taking 
photography lessons.  He also flies radio control airplanes.  Richard’s wife, Lynn who is a nurse at 
Kaiser, has a Sony S350.  

http://www.redlandscameraclub.com/�
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Extended Field Trip To Bryce 

Steve Felber: (951) 769-6898 

Photoshop & Elements tip:  Add a Soft Glow 

Add a soft glow effect to an image using a blur-and-fade effect.  First, finish all your layer work and flatten the 
layers (Layer>Flatten Image).  Next, run a medium Gaussian Blur (Filter>Blur>Gaussian Blur) on the flattened 
image.  Then immediately press Ctrl-Shift-F (MAC: Command-Shift-F) to open the Fade dialog.  Choose Soft Light 
from the Mode menu; vary the Opacity to the desired strength. 

 

 

Our new membership begins April 1st, and as your new Field Trip Coordinator, I will be planning some trips 
to make use of the good spring weather that we can (hopefully) anticipate. 

Just having taken over the new job, I don’t have a specific trip on the calendar yet, but I will soon.  We will 
likely have some wildflower and garden trips, as this is a good year for that.  In May Steve Felber has 
organized the trip to Bryce Canyon, a weeklong field trip.  Not all of us can take a week off, but most of us 
can take a day here and there.   

If you have places that you would like to see organized into a photo field trip, please  contact me at 
jsparhawk746@yahoo.com, to make  suggestions. 

I am also looking for two or three people who would like to assist on the Field Trip Committee.  The 
committee will work together in planning trips and handling some of the logistics.  Let me know if you 
would like to participate in this way. 

I know some of you cannot participate in weekday trips, others love non-weekend trips because of less 
crowded locations.  We will work to have a variety of field trips, different days, different events or locations.  
Sometimes the lead time may be short, but we will attempt to give as much advance notice as possible.  Your 
feedback will be helpful in planning.  So, let’s have a great year out there. 

 

To date, ten members and guests have signed up for our one-week trip to Bryce Canyon National Park. 

This should be a fun-filled trip with lots of great photographic opportunities -- for images, for learning, for 
sharing, for socializing, and for getting to know your fellow club members a little better. 

One of our men members has booked a two-bed room at Ruby's Inn and is willing to share it and carpool if 
anyone's interested.  Hotel rooms are probably getting pretty scarce by now, but the campground should still 
have spaces available for RVers.  The campground also has tent sites (although it may still be pretty cold in 
May), cabins, and tipi's available.   

If there are any other members who would like to come along and have lost the information I emailed in 
early March, please give me a call and I'll re-send the packet.   

If you're thinking of going, better decide soon and get those reservations made!  Ruby's Inn and Campground 
can be reached at 435-834-5301, 800-468-8660, or www.brycecanyoncampgrounds.com. 

FIELD TRIPS 

      Judith Sparhawk 

mailto:jsparhawk746@yahoo.com�
http://www.brycecanyoncampgrounds.com/�
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MEMBERS’ GALLERY 

Spring Digital Competition:  1st Place Ribbons  
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Want to join or renew your membership? 
• Complete this form and bring it to a meeting, along with $20 annual dues, 

• Or  Mail to: P.O. Box 7261  Redlands, CA  92375 (make check payable to: Redlands Camera Club) 

Name: _____________________________  Phone:  (____)  ____ - _______ 

Street Address: ________________________________________________ 
City: ________________________________  ST: _____ ZIP:  ___________ 

E-Mail:  _______________________________________________________ 

New Member    Annual Renewal     

Redlands United Church of Christ 
168 Bellevue, Redlands, CA 

Redlands Camera Club 

7:00 p.m. -- 1st & 3rd Mondays 

 

WHERE 

WE MEET… 


